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What are Google Apps for Education? 
 
Google Apps for Education offers a free set of customizable tools that allows faculty, staff and 
students to work together.  

 Communication – Includes hosted email, shared calendars and chat. 

 Collaboration – Google Docs and Google Sites allows student and teachers to share 
documents online, at any time from any location. 

 Customization – allow IT systems to integrate with Google Apps while keeping the 
school’s domain safe and secure. 

 
 
Mail: 

 Each staff member and student (4-12) has a custom email address 

 7 GB of storage 
Calendar 

 Online shareable calendar  

 Organize schedules 

 Share events, meetings and entire calendars with others 

 Search for events from within your calendar 

 Publish calendars and events on the web 
Documents 

 Word Processing 

 Spreadsheets 

 Presentations 

 Forms 

 Drawings 
Sites 
 
Video 
 
 
You can access all the Google Apps products – Mail, Calendar, Docs, Sites Video – from any of 
the product pages. 
 
In the top left corner of any product, you will see a list of links that will take you directly to the 
product for your school.  
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Google Apps Quick Start Guide 

Log in and start using your email, calendar, and chat features now 

 

Gmail 

Log in to Gmail 

1. Go to your Google Apps Mail page: http://mail.msd549c.org 
2.  Follow the on-screen instructions to activate your account. 

Your Gmail Inbox appears. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

Compose Mail – opens a new message window 
Inbox – show your conversations (the number in parentheses 
indicates how many unread conversations you have.) 
Starred – shows only messages you have marked with a star 
(use stars to mean whatever you’d like). 
Chats – lists your archived Chat conversations 
Sent Mail – show messages you have sent 
Drafts – stores messages you have started and saved to work on 
later. 
Spam – is where we send the messages we think are suspicious 
Trash – is where message you delete end up; you can empty the 
trash whenever you feel like it. 
Custom labels – are used to categorize and identify message 
you receive. The number of in parenthesis indicates unread 
conversations, the color next to the label name indicates the 
color assigned to the label. 
Contacts – lists the email addresses of people you have 
corresponded with; you can add more details as you want 
Tasks – lets you enter and track to-do lists. 

http://www.google.com/url?q=http%3A%2F%2Fmail.msd549c.org&sa=D&sntz=1&usg=AFQjCNE2_RmVK8l3ZM6Gl9xRg-iUT5gUzw
http://www.google.com/url?q=http%3A%2F%2Fmail.msd549c.org&sa=D&sntz=1&usg=AFQjCNE2_RmVK8l3ZM6Gl9xRg-iUT5gUzw
http://www.google.com/url?q=http%3A%2F%2Fmail.msd549c.org&sa=D&sntz=1&usg=AFQjCNE2_RmVK8l3ZM6Gl9xRg-iUT5gUzw
http://www.google.com/url?q=http%3A%2F%2Fmail.msd549c.org&sa=D&sntz=1&usg=AFQjCNE2_RmVK8l3ZM6Gl9xRg-iUT5gUzw
http://www.google.com/url?q=http%3A%2F%2Fmail.msd549c.org&sa=D&sntz=1&usg=AFQjCNE2_RmVK8l3ZM6Gl9xRg-iUT5gUzw
http://www.google.com/url?q=http%3A%2F%2Fmail.msd549c.org&sa=D&sntz=1&usg=AFQjCNE2_RmVK8l3ZM6Gl9xRg-iUT5gUzw
http://www.google.com/url?q=http%3A%2F%2Fmail.msd549c.org&sa=D&sntz=1&usg=AFQjCNE2_RmVK8l3ZM6Gl9xRg-iUT5gUzw
http://www.google.com/url?q=http%3A%2F%2Fmail.msd549c.org&sa=D&sntz=1&usg=AFQjCNE2_RmVK8l3ZM6Gl9xRg-iUT5gUzw
http://www.google.com/url?q=http%3A%2F%2Fmail.msd549c.org&sa=D&sntz=1&usg=AFQjCNE2_RmVK8l3ZM6Gl9xRg-iUT5gUzw
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Four Google Apps Mail features make organizing and finding mail in your account easy: Labels, 
Filters, Search and Priority Inbox.  

Labels 

While you won’t find folders in Apps Mail, you can use labels to organize email messages. 
Because multiple labels can be applied to the same conversation, you have the flexibility to 
manage conversations that my fall under more than one category. 
 
 
By clicking on a label, you can view a chronological list of all conversations that have been 
tagged with that paricular label. Messages with mulitple labels can display in each label.  

Filters 

Create filters that automatically label, archive, delete 
and forward messages and let Apps Mail do the work 
for you. 
 
Click the Settings link in your account and select the Filters tab  
 
OR click on the Create a filter link next to the search box.   
 
 
 
Choosing to Create a new filter lets you specify what messages you want to filter and test how 
the filter will work.  

Search 

Searching in Apps Mail is the best 
way to find messages.  
 
Start at the search bar at the top of the page and type whatever you remember from the 
message; a word or phrase. You can also refine your query by using search operators or the 
advanced search option to find the senders, recipients, subjects, etc. 

Priority Inbox 

Priority Inbox automatically helps you focus on your most important message. Priority Inbox 
splits your inbox into three sections: “Important and unread,” “Starred,” and “Everything else”. 
Messages are automatically categorized as they arrive in your inbox.   



Google Apps Education http://edutraining.googleapps.com/Training-Home Page 7 

 

Signature 

You can set a default signature that will be applied to all sent messages. To set up your 
signature, go to Settings and then the General tab. 
 
 
 
 
 
 
 
 
 
 

Starred Items 

In Apps Mail, you can mark priority messages with the star icon (next to the sender’s name) to 
star a message (click it again to remove the 
star). To see all the messages that you have 
starred, click the Starred link on the left side 
of your account. 
 
 

Tasks 

Google Apps Mail also allows you to keep track of to-do lists. The “Tasks” link appears on the 
left side of your account. Click on “Tasks” to open the to-do list window. In the tasks window, 
click the + icon to get started and add a task. Once you’ve completed a task, check it off the list. 

Out of Office Responder 

When you're away from your email, set up an automatic reply for your incoming messages. In 
the Vacation responder section of your Settings page, enter a message and turn the auto-
response on or off as needed. If you don't want people who are contacting you for the first time 
to receive your auto-response, select 'Only send to people in my Contacts. 

Chat 

Apps Mail provides a chat feature for those times when you want to quickly check in with your 
colleagues. Instead of waiting for email replies, exchange instant messages and get tasks done 
faster. 
 
To start chatting, type in a coworker’s email address in the chat gadget (on the left side of your 
Inbox) and select “Invite to chat” in the drop-down menu that appears. 
 
Once your coworker accepts your invitation, you will see a colored dot next to names in your 
chat list. When they are online, the colored ball is green, red if they are busy, yellow if they are 
idle, and gray if they are offline. Click their name in the list to start a chat conversation. 
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Use Chat in Gmail 

Your Mail window includes a Chat gadget, which lets you send and receive instant messages 
with your colleagues: 

 
 
The Chat window shows a list of people you've recently communicated with. You can also find a 
coworker by starting to type his or her name or email address in the Search, add, or invite box. 
 
To start a chat: Simply point to a user in the list or search results, and then click Chat (or, if you 
haven’t yet chatted with the user, click Invite to Chat): 

 
 
Note: A green dot appears to the left of a contact who is online and available. 
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Google Calendar 

Open Your Calendar 

You can access all the Google Apps products – Mail, Calendar, Docs, Sites Video – from any of 
the product pages. 
 
In the top left corner of any product, you will see a list of links that will take you directly to the 
product for your school. 
 
To open your calendar: Click the Calendar link at the top of your Mail window: 
 
If this is the first time you’ve opened your calendar, you’ll be asked to set your time zone. 
 
Your calendar opens in a new window. 

 
You can also get to your calendar via a URL: 
http://calendar.google.com/a/msd549c.org 
 
  

http://calendar.google.com/a/msd549c.org
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Add Appointments and Events 

Google Calendar makes it easy to schedule meetings, appointments, classes, or events with a 
beginning and ending time. 
You can use any of these methods to add a new calendar entry. 

 Click and drag on your calendar screen to select multiple times and/or multiple dates, fill 
in the Create Event box. 

 
 
 
 
 
 
 
 
 
 

 Create from your calendar list.  
In the calendar list on the left, click on the drop-
down arrow next to the appropriate calendar 
and select Create event on this calendar. 

 
 
 
 
 

 Use the Quick Add link. 
Click on the Quick Add link on the left side of the 
calendar. Type a single sentence and Google will 
interpret what you entered and adds the appropriate calendar entry. 
Enter: What, When, Who, Where 
 
 
 
 
 

Delete or Remove an Event 

To delete or remove an event from your calendar, click the event to display the event bubble. 
You will then see a link to either remove or delete the event from your calendar. 
 
Depending on your ownership of the calendar entry, you will see one of these link options: 
 
Remove from this calendar: This is only available on events you are invited to but cannot edit. 
This will remove the event from your calendar only.  
Delete: This option is only available on events that you have permission to edit. This will 
remove the entry from your calendar and the calendar of any invited guests.   
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Create an All Day Event 

In the default Week view, click on the day in the space above the list of times. This is the open 
space reserved for All Day events. If you want the entry to span multiple days, click the day and 
drag until the end day. 
 
Name your calendar entry. To add more event details click Edit event details. If you are fine 
with just entering a name, click Create Event. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
To change your calendar view: Click the tabs in the upper-right corner of the view: 
 
 
 
 
 
 
 
 
 
 
 
To view or edit details about an event: Click its name: 
                                                   

To create an event: Click Create Event: 
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Calendar Views 

With Google calendar, you can choose to view calendar information by day, by week and by 
month. You can also get a list of calendar events by using the Agenda view. You can also 
customize your calendar view to display as many days as you want in one view. 
 
To change between different views, click on the tabs in the top-right corner of your calendar. Or 
to quickly customize your view, just click and drag on your mini-calendar from your desired 
start date and drag to your desired end date.  

Day View 

The Day view displays events for a single day. To use this view, click on the Day tab in the top-
right corner of your calendar. 

 
Use the single arrows on the top-left corner of the calendar to move forward or backward by a 
day.  
 
 
 
 
 
 
 
 
 
 
Click on Today to return to the current day, or select a date you want to view on the mini-
calendar displayed on the left side of the calendar.  
 
If you have an All Day event, it will be displayed at the top of the Day view enclosed in the blue 
box area. If you have multiple All Day events, you have the option to hide or unhide them using 
the arrow to the left of the All Day event section.  
 
While in any other view (Week, Month, Agenda or the custom day), you can double-click on a 
day in the mini-calendar on the left and switch to the Day view. 
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4 Day View 

The Custom View (Next 4 Days) tab defaults to the next four days but is also customizable. 
 
In this view the current day will be marked with a yellow background. Use the single arrows on 
the top-left corner of the calendar to move forward or backward by a four-day increment. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
If you want you can alter the Custom view (Next 4 Days) tab in the top-right corner of the 
calendar to create your own customized calendar view.  

1. Click Settings in the top right corner of your calendar window. 
2. Make sure you are on the General tab. 
3. In the Custom view section, select the desired time range from the drop-down menu 

(from 2 days up to 4 weeks). 
4. Click Save at the top or bottom of the page. 

Now the fourth tab will say whatever time increment you selected. To change the setting, 
repeat the steps above. 

Week View 

The Week view displays events for the current week. To use this view, just click on the Week 
tab in the top-right corner of your calendar. 
 
The current day will be marked with a yellow background. If you have an All Day event, it will be 
displayed at the top of the Day view enclosed in the blue box area.  
 
Use the single arrows on the top-left corner of the calendar to move forward or backward by a 
week. 
 
You can switch to the Day view by clicking on a date displayed at the top of the Week view or 
double-clicking on a date in the mini-calendar. 
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Month View 

The Month view displays events for the current month. Click on the Month tab in top-right 
corner of your calendar.  
 
The current day will be marked with a yellow background. Use the single arrows on the top-left 
corner of the calendar to move forward or backward by a week. 
 
You can switch to the Day view by clicking on a date displayed at the at the top of the Month 
view or double-clicking on a date in the mini-calendar. 

Customized View 

You can quickly customize the view of your calendar to be as many or as few days as you like 
using the mini-calendar on the left. 
 
To quickly view a set of days on your calendar, follow these steps: 

1. Click on the start date in your mini-calendar on the left side of your calendar window 
and drag to your desired end date. 

NOTE: this will not be a default calendar view or take the place of the 4 Days tab in the top 
right. This is just a quick way to view multiple days in your calendar. 
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Agenda View 

Use the Agenda view to view all your events grouped by day. This view lists the timing of each 
event beside the event name.  
 
Today is indicated with a yellow background. All Day Events are displayed on the top of each 
day. If there are more events than what is displayed, you can scroll using the arrows on the 
right and then click the Look for more link if you’d like to view more events. 
 

Each of the events listed shows the timing, the name and some of the basic event details. You 
can click on the name of the event to expand it and show more structured information.  If you 
would like to see all events with this additional information, you can click the Expand All link at 
the top left of the calendar view. To minimize all the event details, click Collapse All. 
 
You can use the single arrows on the top-left corner of the calendar to move forward or 
backward to view more days.  
 
In the agenda view, it is easy to have a full list of activities for each day. This can be useful for 
detailed lesson planning. Create a daily lesson plan: 
http://edutraining.googleapps.com/Training-Home/module-3-calendar/chapter-4/3-2 

Calendar Details 

Google Calendar by default opens 
to the Week view. To make 
changes to the default settings for 
the calendar click on the Settings 
button in the top-right corner of 
your calendar window. 
 
  

http://edutraining.googleapps.com/Training-Home/module-3-calendar/chapter-4/3-2
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Create and View Calendars 

Your Google Apps school account will create a primary calendar for you; it can also be useful to 
have several additional calendars to help organize your life. The primary calendar will be 
associated with the name and email address of your account; however you can create as many 
secondary calendars as you like.  
These different calendars will allow you to see different information on your calendar, you can 
also color code the calendars and you can set different privacy settings for calendars. 
 

Create a New Calendar 

To create a new calendar, click on the Add button in the left hand column 
below your My calendars list.  
Enter the required information: 

 Calendar name – this will appear in the list of your calendars. 

 (optional) Description – this will appear in your calendar details. 

 (optional) Location – Specify a location (country, city, state, 
school) 

 Calendar time-zone 
Click Create Calendar 
 
All of the calendars you create will be listed under “My Calendars” on the left side of your 
calendar page. For each of the calendars, you can add, delete, and edit events any time you 
like. 
 
NOTE: there is a limit to the number of calendars you can create at one time. If you are getting 
an error message when creating additional calendars, please wait 24 hours before trying again.  
 

Calendar Privacy 

To set a calendar to private follow these steps: 
1. In the calendar list on the left, click the down-arrow 

button next to the appropriate calendar, then select 
Share this calendar. (Alternatively, click the Settings 
link at the bottom of the calendar list, select a 
calendar and click the Share this calendar link). 

2. Check that the Share this calendar with others 
general setting is NOT selected.  

3. Also, be sure NOT to add anyone in the Share with 
specific people section. If you do add individuals 
here, they will be able to see your personal calendar. 

 
When creating events, make sure that the radio button next 
to either Default or Private is selected under “Privacy” on the event 
details page. This will make sure that even if someone has access to 
your calendar, they can only see that you are busy and not see any 
of the event information. 
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Share Calendars 

You control who you share your calendar with and what information others can see. You can 
change your calendar sharing settings to any of the following options: 

 Share with everyone 

 Share with my domain 

 Share with specific people 

To add a calendar, follow these steps: 

1. At the bottom of the calendar list on the left, click Add and select Add a coworker’s 
calendar. 

2. Enter the appropriate email address in the field provided, then click Add. 
 
If the other teacher or student has opted to share his or her 
calendar publicly, it will then appear under Other Calendars in the 
left column. If not, you’ll see a message requesting access to their 
calendar. Feel free to add a note to the request, then click Send 
Request. 
 
Once they have granted you permission to view their calendar, 
you will receive an email confirming your access. The calendar will 
also automatically appear in your calendar list the next time you 
sign in to Google Calendar. 

Sharing Calendars 

Besides creating a personal calendar to help organize your own activities and priorities, it can 
be useful to create calendars to share information across groups of people. 
 
Here are some examples of group calendars that could be used at your school: 

 Class calendar for class-related events such as activities, class meeting times, testing 
schedules, and lesson objectives. 

 Homework calendar with detailed descriptions of homework assignments and due 
dates. 

 School-wide holiday or academic schedule with in-service days, holidays, and other 
scheduling anomalies.  

 Group project deadlines & milestones for a group or team to track workload 
 School sports event schedules that can be shared with the entire school. 

 
If you use your personal email address with Google Calendar you have the option to keep a 
calendar private or to share it with the entire web.  However, with Calendar for Google Apps 
you have a third sharing option.  You can choose to keep a calendar private, to share it with the 
entire world, or to share it with only members of your domain.  If you share it with members of 
your domain then the calendar can only be accessed with those who have an account 
on msd549c.org. 
 
With the sharing options available, it is easy to create a school calendar with varying levels of 
access – you can specify certain users that can make changes, others that can only see the 
calendar, or set a broad access setting for the public or individuals at your school. 
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Access Levels 

The following are the different types of access levels you can grant to individuals, users at your 
school, and the public (everyone in the world). 
 

1. Completely private calendar: Do not share with everyone/everyone in my domain 
You can set your calendar to be completely private so that none of your calendar 
information, not even free/busy information, will be available to anyone except those 
people you specifically added to share your calendar. 
 
You can use this setting for the entire world (Do not share with everyone) and/or for 
your school Apps domain (Do not share with everyone in my domain). 
 
There are two cases that will override this: 

 If you invite someone outside your domain to a meeting, he or she can see 
information about the meeting, but nothing else about your calendar. 

 If you share your calendar with someone outside your domain, he or she can see 
free/busy information on your calendar. 

2. Limited calendar view: free/busy information 
Sometimes you want people to be able to check your schedule and see only the times 
you are busy. In the free/busy view, someone will only see blocks of time marked as 
busy for times when you have entries in your calendar. They will not be able to see the 
name of the event or any of the event details.  
 
The view can be useful to share as an ‘appointment availability’ calendar that you could 
share with students or parents. This way the students or parents can see when you are 
available without knowing any of the details of your schedule. 

3. Full calendar view: show all event details 
With this setting, other users can see your calendar and events and invite you to events, 
but cannot see events on your calendar that have been marked as private. 
 
This is a common view for school-related calendars that are shared with users at your 
school domain. For that calendar, your colleagues or students would be able to see the 
events and details. 

4. Full calendar access: Make changes to events – for sharing with individuals only 
You can add specific people to a calendar who have access to see and change all events, 
including private ones. 
This can be useful for team calendars as it allows multiple people the ability to add or 
edit events on a single calendar.  
 
Please note: You cannot grant someone outside your domain this level of access to your 
primary calendar (this is the calendar created by default with your Google Apps 
account). However, any secondary calendars can be shared - such as a calendar created 
specifically for homework, school projects, school sports events, etc. 

5. Full calendar ownership: Make changes to events AND manage sharing – for sharing 
with individuals only 
The final privilege you can grant to an individual is the ability to manage sharing access 
for a calendar. With this setting, an individual would essentially become an owner of the 
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calendar as they would be able to add, remove, and edit events as well as add, remove, 
and edit the sharing settings of the calendar. 
 
This is a setting to be treated with care: someone with this permission would be able to 
change the sharing access level of individuals or change if the calendar is viewable to the 
domain or public. 
 
Please note: You cannot grant someone outside your domain this level of access to your 
primary calendar 

Sharing the Calendar 

To set broad access levels in a personal calendar, follow 
these steps: 

1. In the Calendar list on the left, click the down-
arrow button next to the appropriate calendar, 
then select Share this calendar.  

2. The first option is to set broad access to your 
calendar: the public (anyone in the world) and 
your domain (anyone who has a Google Apps 
account at msd549c.org. 

 If you want to share your calendar very 
selectively by choosing individuals, leave this box unchecked. 

 If you would like to give broad access to your calendar with the public or with 
members of your school that have Apps accounts, then check the box. 

3. If you choose to share with either of the 2 groups, you can select a sharing option: 
 

 To share a calendar with the entire world, check the Make this Calendar public box. 
o You can then choose to show all event details with the public, or only your 

free/busy information. 

 To share a calendar with just those in your district who have a Google Apps account, 
check the Share this calendar with everyone in the domain msd549c.org 

o You can then choose to show all event details with members at your school 
or just display free/busy information  

o This sharing option is useful for school-related calendars, as you can share a 
homework or class calendar with the entire school so that any teacher or 
student would be able to view. 
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Google Weather 

Google Calendar’s Weather feature displays the weather forecast directly in your calendar.  
To view weather forecasts in Google Calendar, follow these steps: 

1. Click the Settings at the top of any Google Calendar page. 
2. Select the General tab. 
3. In the Location section, enter your desired location information. 
4. In the Show weather based on my location section, select either °F or °C. 
5. Click Save. 

Once you have enabled the Weather feature, a Weather Calendar will be added to your 
calendar list. You will also see weather icons in the upper left corner of today and the following 
three days in your calendar.  
Each icon serves as a visual representation of the forecast for that particular day. For more 
detailed information, including a brief description, location, and high and low temperature, click 
the weather icon or point your mouse to it.  

Import Outlook Calendar 

If you have a calendar in MS Outlook, you can export from Outlook and import into Google 
Calendar. Follow these steps: 

1. Open Outlook and go to File…Import and Export…Export to a file. 
2. Select Comma Separated Values (Windows). 
3. Select the calendar you want to export, save it to your desired location, then click 

Finished. (Note: When exporting more than one year's worth of data, we recommend 
that you divide your calendar into multiple, one-year segments and export each file 
separately; otherwise, you may encounter errors.) 

4. Select the desired date range of events to export, then click OK. 
5. In Google Calendar, ensure that you’ve create the calendar that you’d like to migrate 

events to. Then at the bottom of the calendar list on the left, click the Add drop-down 
arrow button and select Import Calendar. 

6. Click Browse and select the appropriate file, then select Open. 
7. From the drop-down menu, select the calendar that you want to import events to, then 

click Import to complete the import. 
NOTE: The exported file does not support recurring Outlook events. Individual items will be 
created for recurring events that fall between the dates you have selected. 
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Print Calendar 

Sometimes it's handy to have a print-out of your calendar to take with you. 
 
To print a calendar or multiple calendars, follow these steps: 

1. Make sure that the calendar(s) you want  to print are selected in the calendar list to the 
left of your calendar window. (The calendar names will be highlighted by a colored bar.) 

2. Click on the view that you would like to print: Day, Week, Month, 4 Day, or Agenda. 
3. Click the printer icon to the left of the calendar's view tabs (Day, Week, Month...) 

 
4. A 'Print Settings' menu will appear in a new window. Simply select the desired options 

for your printed calendar. 
o Font size/Orientation: Choose the size of the font and the orientation of your 

calendar (landscape/portrait) 
o Events you have declined: Choose to have events appear even if you have 

declined. 
o Black/White: Check if you want to print in black and white. 
o Agenda view only options: 

 Print range: Select the dates you would like to print of your calendar. 
 Descriptions: If you would like to have all the details for your activities 

printed, select the Print descriptions check box (Please note: this is not 
checked by default.) 

 End times 
 Attendees 
 My response 
 Events you have declined 

5. Click Print. - Alternatively, if you would like a PDF copy of your lesson plan, click Save 
as - this will download a PDF file of your lesson plan calendar. 

 
Please note that if you've scheduled a large number of events, your calendar may print on 
multiple pages to better display all your entries. 

 
  

http://edutraining.googleapps.com/Training-Home/module-3-calendar/chapter-4/3-4/print link.png?attredirects=0
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Google Docs 
 
Google Docs offers word processing, spreadsheets, presentations, forms and drawings. These 
provide an easy-to-use, integrated way for teachers and students to work together on projects, 
reports and more, and to collect and share information in a secure online environment. Built-in 
tools like autosave and revision history, comments and an equation editor are useful for 
students and teachers.  
 
Some of the advantages of using Google Docs include: 
Anytime, anywhere access Web-based Google Docs safely stores documents online, 

makes them accessible to authorized users from any 
computer or mobile device. No need to save files to a USB 
thumb drive, you can always access your files from any 
internet browser. 

 

Collaboration support Google Docs lets users easily invite others to work on the 
same document, at the same time, without the hassle of 
attaching and sending documents. Sharing privileges ensure 
access by only the right people or groups, and allow either 
editing or read-only access. 

 

Autosave and revision history Continuous autosave ensures that current work stays sage, 
preserving ongoing drafts and edits. A complete revision 
history makes it easy to review, compare, or revert to a prior 
version at any point. 

 

Shared Folders Files and docs that are regularly used by teams or groups stay 
organized and up-to-date – without the need to manage and 
communicate changes. 

 

Templates Ready-made templates covering a wide range of document 
and report types help jump-start writing projects. You can 
also create and publish your own document templates to 
establish assignment structures for your students. Templates 
can be copied with one click and then modified like any other 
document. 

 
You can access Google Docs from any of your school Google Apps product pages.  

1. In the top left corner of any product main page, you will see a list of links. 
2. Click Documents. 

 
In addition to the links at the top left of any Google Apps page, you can also access Google Docs 
through the district URL: 
Type:  https://docs.google.com/a/msd549c.org into your browser address bar.  
  

https://docs.google.com/a/msd549c.org
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Documents 
There are different ways of getting started using Google documents: you can create a new 
online document, you can upload an existing one or you can use a template from the templates 
gallery. 
 
From your Docs list 

To create a new document, go to your Docs list, click the Create new drop-
down menu, and select Document.  
 
 
 
 
 
 
 
 

From an existing Doc 
You can create a new document while in an 
existing document, spreadsheet, presentation 
or drawing. Click the File menu, select New 
and choose Document. 
 
 
 

Upload and convert 
You can also upload a variety of file types into 
Google Docs and have it automatically convert 
into a document.  
When you upload a file, a box that indicates the 
progress of the upload appears in the bottom 
right of your screen. You can minimize the box or 
move it to the left or right of the screen. When 
you’re done, you can click the document title to 
open the uploaded file or close the box by 
clicking the x in the upper right of the box. 

 
To add items to your docs list, you have a few options.  

Convert Attachments to Google Docs 
When you are using Apps mail, Google will automatically detect supported file types for your attachments 
and offer an option to open the attachment using Google Docs, either as a Google document, 
spreadsheet, or presentation. When you open the attachment in Google Docs, you don't need to 
download the file to your computer (unless you want to keep the original formatting) and it will be 
available with the rest of your Google Docs files. 
 
To automatically convert an email attachment to Google Docs, click the "Open as a Google spreadsheet" 
link in the attachment area at the bottom of the message. The document will then convert in a new 
window for you to view and edit as you would with any other file in Google Docs. 
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Import/Export Options 
You can easily import and export files in Google Docs 
 

  Docs Spreadsheets Presentations Drawings 

Import Microsoft Word (.doc, .docx) 
OpenDocument text (.odt) 
StarOffice text (.sxw)  
Rich text (.rtf) 
Plain text (.txt)  
HTML (.htm, .html) 

Microsoft Excel (.xls, .xlsx) 
OpenDocument spreadsheet 
(.ods)  
Comma-separated values (.csv, 
.txt) 

Microsoft Powerpoint (.ppt, 
.pps) 

N/A 

Export Microsoft Word(.doc) 
OpenDocument text (.odt) 
Rich text (.rtf) 
Plain text (.txt) 
HTML (.htm, .html) 
PDF 

Microsoft Excel (.xls) 
OpenDocument spreadsheet 
(.ods) 
Comma-separated values (.csv, 
.txt)  
PDF, HTML 

Microsoft PowerPoint 
(.ppt) 
PDF (.pdf) 
Text (.txt) 

PNG, JPEG, 
SVG, PDF 

 
You can also convert documents to a Google Docs format if you happened to upload it in an unconverted 
format. While in the document list, right-click on the file you want to convert and select Make a Google 
Docs copy. This doesn’t modify your original file and adds a new Google Docs copy to your docs list.  

  
 

Sharing, Privacy, Printing and Publishing 

In Google Docs, when you want to send a document for others to see or edit, you don’t need to 
email an attachment or upload a file for others to access. Instead, you can share one online 
version of your document and specify who has permission to make changes and who has 
permission to only view. 
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Many people can access a Google Doc at the same time, just like many people can look at the 
same webpage or the same photo shared online. Sharing documents online makes it easier for 
groups to work together, wherever they are. 
 
Google Docs lets you know who else is looking at the document and exactly where they are 
making changes. 
 
You can also start a discussion with others in the document using the built-in chat feature. 
 
With Google Docs you have 2 types of settings for making documents available to others. They 
are: 

 Visibility settings: how people can access your document  

 Sharing settings: who can make changes or view the document 
 
You can share your docs with just the people you want, and you can specify exactly what level 
of access (view or edit) each person has for each document. 
 
When you create a new doc, you are automatically the owner and the document is available 
only to you. You can choose to share it with individuals or groups in one of three types of roles 
with sharing privileges: 
 
Owners: 

 Can edit documents, spreadsheets, presentations, and drawings and invite more editors and 
viewers. 

 Can delete documents, spreadsheets, presentations and drawings and thereby remove 
access for editors and viewers. NOTE: to fully delete a document, spreadsheet, presentation 
or drawing and remove access to it, you need to delete it and then Empty Trash. 

Editors: 

 Can edit documents, spreadsheets, presentations, and drawings. 

 Can invite or delete other editors and viewers (if the owner has given them permission). 

 Can export a copy of the document, spreadsheet, presentation, or drawing to their local 
hard drive. 

 Can view a list of editors. 

 Can make a copy of a doc, and copy the list of doc’s editors. 
Viewers: 

 Can see the most recent version of a document, spreadsheet, presentation or drawing but can’t 
make any changes. 

 Can export a copy of the document, spreadsheet, presentation, or drawing to their local hard 
drive. 

 Cannot view the list of editors. 

 Can make a copy of a doc, but can’t copy the list of doc’s editors. 

 

Visibility options: Private, Anyone with the link, and Public on the web 

There are 5 different visibility options: private; people at my organization with the link, people 
at my organization can find and access, anyone with the link; and public on the web. And you 
can see how your doc is set by looking at the icon right next to its title.  
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Private 
When you create a private doc, you are the only person with access to it. From there, you can 
grant access to other people. Anyone trying to access the document will have to sign in to their 
Google Account to verify that they have access to the doc.  
Private is the best setting for your own private documents. It is also good if you want to 
collaborate within a closed circle of people. 
 
People at your organization with the link 
Docs set to this option are accessible to anyone inside the domain who knows the URL of the 
file. If you also select the ‘Allow anyone to edit’ option, anyone with the URL will be able to 
view and edit your file. This option allows you to easily copy and paste the file’s link into chat, 
email and calendar invites for quick access and feedback. 
 
People at your organization can find and access 
Docs set to this option will be indexed by Google Docs search and may be opened by anyone in 
your organization. 
 
 
 
 
 
 
 
 
 
 
 
 
 
You can share a doc or file with 200 viewers and editors (combined), or you can make your doc 
available to anyone by changing its visibility option. 

Share Docs Inside Your Domain 

With Google Apps Education Edition, you will always be able to share a document with others 
in your district domain (msd549c.org). 
When you share with an individual you can select what level of access (view or edit) each 
person has. 
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Here’s how to add specific editors and viewers: 
1. Open the doc you want to share. 
2. Click Share in the upper-right corner of the doc. This will open the Sharing settings 

window. 
3. At the bottom of the Sharing settings window, under ‘Add people,’ type the email 

addresses of the people you want to share with. You can add a single person, multiple 
people, or even choose from a list of your contacts. 

 
 

4. To the right of the list of names, choose ‘Can view’ or ‘Can edit’ from 
the drop-down.  

5. Two quick options to consider: 

 By default, people who can edit your doc will also be able to 
share it with additional people. You can remove that ability by 
clicking Change next to ‘Editors are allowed to add people…’ 
before you click Share. 

 
 By default, everyone you share the doc with will get an invitation email. If you would 

rather not notify them, un-check the ‘Send notifications’ box. They’ll have access the 
next time they sign in. 

6. Click Share. 

Sharing Docs with a Group 

You might want to share a document with a specific group (a class, a grade level, a club, etc.). 
Instead of entering the names individually, you can use Groups in Google Apps. 
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A group is a single email address that includes multiple members from an Apps domain and can 
be used to share calendars, sites and documents. When something is shared with that single 
group address, it is then shared with all the group members. 
 
Sharing with a group follows the same steps as an individual. You can also assign whether the 
group has edit or view access. Note that the access level is the same for every member of the 
group.  
 
To share documents with a Group created in Google Apps, follow these steps: 

1. Open the doc you want to share. 
2. Click Share in the upper-right corner of the doc. 
3. At the bottom of the Sharing settings window, under ‘Add people,’ type the email 

address of the group you want to share with. 
4. To the right of the group name, choose ‘Can view’ or ‘Can edit’ from the drop-down. 
5. Click Share. 

NOTE: when you share the document with a group email, they will need to first open the 
document before it will appear in their doc list. Once they open the document, it will always 
appear in their doc list.  

Share with Everyone in Your Domain 

If you have a document that you would like everyone in your domain to be able to view, you 
can select it to be available to everyone in your school Apps domain.  
 
To do this, you can change your document visibility settings to the option:  

 People at your organization with the link: With this setting, your document will be 
accessible to anyone within your school domain who knows the URL of the file. If you 
also select the ‘Allow anyone to edit’ option, anyone with the URL will be able to view 
and edit your file. This option allows you to easily copy and paste the file’s link into chat, 
email and calendar invites. You would then have to make sure all at your school had 
access to this link (either on a website or sent via email) for them to be aware of the 
document. This document will not automatically appear in everyone’s doc list, it will 
only appear if they have opened the document. 

 People at your organization can find and access: With this setting, your document will 
be indexed by Google Docs search within your domain and may be opened by anyone in 
your school Apps domain. This means that if someone was searching Google Docs your 
document could show up as a result. However, the document will not automatically 
appear in their doc list until they have opened the document.  
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In both of these options, you will need to share the link with your domain for them to be able 
to access the document – it will not automatically appear in their doc list. 
 
The sharing limitation for viewing the document does not apply with visibility settings, 
however, the limitation for editing a document still applies. Only 50 people can be editing a 
document at any given time. However, if you gave the school domain only View access, then 
you shouldn’t run into this problem. 

Share Docs Outside your Domain 

Documents cannot be shared outside our domain. If you enter an email address that is not in 
our domain you will see the following message. 
 

 

Who Has Access? 

You can check to see who has edit or view access to your document at any time by clicking the 
Share button in the top right corner of the doc. 
 
You will see a full list of all the individuals or groups who have access to the document as well 
as their access level. 
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Email Docs as an Attachment 

In addition to sharing online you can also send an email attachment to anyone in the world 
directly from Google Docs with a formatted attachment of your document. 
 
To send your document as an attachment, follow these steps: 

1. Click the Share drop-down menu, and select Email as attachment… 

 
2. Select a file type from the dropdown menu: 

 Documents: MS Word, Open Office, PDF, HTML, Rich Text, or Plain Text. 

 Spreadsheets: MS Excel, Open Office, or PDF 

 Presentations: PDF, Power Point, or Plain Text Enter and email address 
3. If you want, you can also add a subject and a message. 
4. Click Send. 

People to whom you are emailing this doc will receive it as a downloadable attachment in the 
file format you selected. 
 
Although the file send as an email attachment is editable offline by each recipient, these edits 
won’t be reflected in the original Google document or spreadsheet. 

Email Contents of Document 

The word processing document type in Google Docs also allows an additional option to paste a 
document directly into an email instead of sending an attachment.  
 
This can be useful to compose newsletters or other updates that you prefer to send in an email 
format rather than sharing or publishing a document. 
 
To send an email with the contents of the document, follow these steps: 

1. Click the Share drop-down menu, and select Email as attachment… 
2. Select the ‘Paste the item itself into the email” option. 
3. Enter an email address, or multiple addresses. You can also add a subject and a 

message. 
4. Click Send. 

 
People to whom you’re emailing will receive the document  
contents in the email. 
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Publish Docs to the Web 

Publishing to the web allows you to make your Google Docs available as a webpage that anyone 
in your domain or the world can view without specifically inviting them to collaborate. Once 
you publish your document, spreadsheet, presentation, or drawing to a webpage, you get a URL 
that can then be shared, bookmarked, and sent as you would any other webpage address. It is 
also necessary to publish documents if you want to embed them on blogs or other websites. 
 
If you send the URL of the published version of your document, spreadsheet, presentation, or 
drawing to others, they won’t be able to make any edits. 
 
This is what they will see: 

 Documents: a version with no toolbar available 

 Spreadsheets: no toolbar available. Viewers will be able to see charts, cell 
formatting, and the values of cells; they won’t be able to view or edit formulas. 

 Presentations: view-only version or in presentation mode (full-screen slides_ 

Publish 

If you are the owner of a spreadsheet, document, presentation or drawing, you can publish it to 
the Web at any time. If you selected the ‘Editors will be allowed to add people and change the 
permissions’ option, those who have edit access can also publish the document.  
 
To publish any of your docs, just follow these steps: 

1. Open the doc you want to publish. 
2. Click the Share drop-down menu on the top right of the page and select Publish to the 

Web… 
3. You can choose whether you would like the published doc to be automatically updated 

if you make any changes.  
4. You can also ensure secure access to your document by requiring those at your school 

Apps domain to sign in before viewing the document. 
5. Click the Start publishing button. A link to the published doc appears in the publishing 

dialog. 
6. Send this link to anyone you’d like to access your doc. 

 
Your doc will be accessible from this URL until you either delete your doc or choose to stop 
publishing. 
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Types of Publishing 

Documents, presentations, and drawings are all published as an HTML file, just like a webpage. 
 
Spreadsheets can be published as multiple types including: 

 HTML 

 CSV (comma separated values) 

 TXT (Plain text) 

 PDF 

 XLS (MS Excel) 

 ODS (Open Document Spreadsheet) 
When publishing a spreadsheet, under ‘Get a link to the published data,’ you can select a 
format from the drop-down menu to get a unique public URL for the sheets or range of data 
you have selected to publish. 

Stop Publishing 

You can stop publishing documents at any time, just follow these steps: 
1. Open the doc you have published. 
2. Click the Share drop-down menu on the top right of the page and select Publish to the 

Web… 
3. Click the Stop publishing button. 

 
Now anyone clicking the link to the published doc will no longer be able to access it. 

Tracking Visits to Published Documents 

You have the ability to track how much traffic a published word processing document is getting 
through Google Analytics, just as you might on a traditional webpage. 
 
If you are interested in using this function please go to this link follow the directions. 
http://edutraining.googleapps.com/Training-Home/module-4-docs/chapter-2/8-5 

  

http://edutraining.googleapps.com/Training-Home/module-4-docs/chapter-2/8-5
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Print a Word Processing Document 

Printing documents in Google Docs generates a PDF file that you can then open and select to 
print. 
 
If you want to print directly to a PDF without choosing Print settings: 

1. From within the document you’d like to print, select Print from the File menu. 
2. A PDF is downloaded in your browser. 

 
If you’d like to change your print settings before printing, follow these steps: 

1. Choose Print settings or Page setup from the File menu. 
2. In the Print settings menu you can select if and where you can print your page 

annotations (like page numbers). 
3. In the Page setup you can choose how your document will appear with the following 

specifications: 

 Page orientation: landscape or portrait 

 Paper size 

 Margins: top, bottom, left, and right 

 Page color 

 
4. Once you’ve selected your specifications, click Print at the bottom of the settings 

window. A PDF will be downloaded in your browser. 
  



Google Apps Education http://edutraining.googleapps.com/Training-Home Page 34 

 

Print a Spreadsheet 

Printing spreadsheets in Google Docs generates a PDF file that you can then open and select to 
print. 
 
If you want to print directly to a PDF without choosing Print settings: 

1. From within the document you would like to print, select Print from the File menu. 
2. Click the Print button. 
3. A PDF will be downloaded from browser and you can open and print. 

 
If you'd like to change your print settings before printing, follow these steps:  

1. Choose Print from the File menu. 

 

 

 

 
 

2. Select the following options  
o Print one sheet or all sheets in a single spreadsheet. 
o Adjust the size to 'fit to width' or 'actual size.' 
o Choose either a landscape or portrait layout. 
o Select your paper size - Letter, Legal, or A4 (standard 

for most European printers). 
3. Click Print at the bottom of the settings window. A PDF will be downloaded in your 

browser. 

NOTE: If your spreadsheet has sheets with full-page charts and gadgets, those sheets won't be 
printed. All other sheets in your spreadsheet, however, can be printed.  
 
To print your spreadsheet without gridlines, follow these steps:  

1. Publish the spreadsheet you'd like to print. Review the previous section on publishing 
docs » 

2. Once you publish, a unique, published URL will be generated. Click this link to view your 
published spreadsheet. 

3. To remove the gridlines, type "&gridlines=false" at the end of this published URL.  
4. The gridlines disappear from the published spreadsheet. 
5. In your browser's menu bar, select File > Print. 

Printing documents in Google Docs generates a PDF file that you can then open and select to 
print.  
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Print a Presentation 
To print a presentation, follow these steps:  

1. Click Print... from the File menu of the presentation you'd like to print. 

 

2. A new window opens, displaying your presentation as it will appear when printed. From the 
Layout menu, select the number of slides you'd like to appear on each page. 

 

3. Click Print. 
4. Open and print this PDF with Adobe Acrobat. 
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Preview a Word Processing Document 

You can preview a word processing document before printing it by selecting Print preview from 
the File menu. 
 You will then see a page that shows you how your document will look when it is downloaded 
as a PDF and ready to print.  

On the right margin, you will see smaller images of the document pages. You can navigate 
through the pages by clicking them or by using the arrows at the top right of the document. 
 
If you want to zoom in or out on a document, click the + or – buttons underneath the 
navigation arrows. If you have four pages and would like to see all pages on one screen, keep 
zooming out until you can see them all. You can also click the buttons in between the zoom 
in/out keys to see either one or two pages per screen view. 
 
From the print preview page, click either Close preview or Print on the toolbar at the top of the 
window.  

Documents 

Some examples of how teachers can use online documents: 

 Collaborate and share curriculum plans 

 Consolidate notes for department or faculty meetings 

 Create a simple webpage with docs publishing 

 Share and collect assignments without printing 

 Provide instant feedback to students 
 
Some examples of how students can use online documents: 

 Improve writing skills through peer editing and feedback 

 Access documents in class or at home 

 Work on reports, research, or papers together with peers in different classes, schools, 
countries 
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 Keep a continuous, running log for assignments such as journal entries, writing samples, 
etc. 

 

Manage Documents with Multiple Editors 

Google Docs enables multiple people in different locations to collaborate simultaneously on the 
same doc from any computer with Internet access. 
With everyone working on the same doc, there’s no back and forth of versions and edits. This 
can also accelerate the feedback and revision process, allowing teachers to provide quick 
comments and students to incorporate changes as they’re writing. 
 
If you and another collaborator are editing the same document at the same time, a box with 
the name of the collaborator appears at the top of the screen. 
 
If other people are editing a document simultaneously with you, you'll see their edits in real 
time. You can also see the text that other editors are highlighting as they select it. If someone is 
about to delete something on your screen or drag text somewhere else, you’ll see them 
highlight that text before anything changes. 
 
You also have the ability to see their names listed at the top of a document. Click the arrow to 
the right of the names to open a tab where you can chat with other editors within the 
document. 
 
Working in groups makes the autosave and revision history feature especially helpful. 
Since copies of your document are saved anytime a collaborator makes edits, it is easy to check 
and see who made what edits and when.  
To browse previous versions of a shared document, follow these steps: 

1. From your document, click File…See revision history. 

 
2. Changes are color-coded based on each collaborator, making it easy to tell what has 

been added or deleted. This is perfect for evaluating group projects, participation and 
more. 
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3. While viewing the revision history, you can show more detailed revisions by selecting 
Show more detailed revisions. 

 
If you change your mind about the most recent edits you or your collaborators made to 
the document, simply revert to an older version by following these steps: 
1. Click down through the edits until you find the revision you want. 
2. Click Restore this revision. 

 
Your document is reset to the version you selected. Now when your collaborators view this 
document, they will see the version you selected.  
 
Up to 50 people can edit a document at the same time. You can share a document with up to 
200 people. 

Comments 

Comments are a convenient way of adding notes to your document text and are visible to 
viewers and collaborators.  
Comments are helpful for the freeback and revision process, as teachers or peer editors can 
add ideas or questions without disrupting the contents of the document. You can highlight as 
many or as few words as you want to begin a comment. 

 
To add a comment to your document, follow these instructions: 

1. Place your cursor or highlight the text where you would like your comment to appear. 
2. From the Insert menu, select Comment. 
3. You can also use the keyboard shortcut (CTRL+ALT+M) to insert a comment. 
4. Type your comment in the box that appears to the right of the 

document. 
5. Click Post to post the comment or 

Cancel to cancel the comment. 
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Working with Comments 

After inserting a comment, there are two main places you can work with it inside the 
document: within the comment or in the discussions thread, accessible from the Discussions 
drop-down menu in the top right of your document. 
 
You can reply to a comment with a new post, edit or delete a previous comment you have 
inserted, and resolve the discussion when you are ready to remove it from the document. 
Resolving a discussion removes the discussion from the document, but resolved threads will 
always be available under the Discussions drop-down menu. 

 

Document discussions 

From the Discussions drop-down menu in the top right of your document, you can review all 
discussions, including those discussions that have been resolved. From this menu, you can also 
change the notification settings for discussions. 

 

Chats in Documents 

Google Docs now supports chat directly in the document without interfering with the contents 
of the document itself. 
 
Chats are not saved with the document like comments or regular edits, but are primarily used 
for discussing a document among editors.  
 
To start chatting with collaborators in a document, follow these steps: 

1. Find the list of names at the top of the document – it there are no names, then no one 
else is editing the document and you cannot begin a chat. 

2. Click the arrow to the right of the names to open a tab. 
3. The names of those editing the document will appear in the chat window. 
4. Begin typing and chatting. 
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Email Collaborators 

Communicating with other collaborators is useful when you want to notify others of changes 
you made or send a message about the document. 
 
You can easily email other collaborators directly in the document, just follow these steps: 

1. Click the down arrow on the right side of the Share button in your document. 
2. Select Email collaborators from the drop-down menu. 

 
3. Choose the collaborators you want to notify, deleting any you don’t want included. 
4. You can modify the subject (by default it is the name of the document) and enter a 

message to the collaborators. 
5. Click the Send button. 

Improving the Writing Process with Docs 

With Google Docs, files are accessible from any computer connected to the internet. Online 
documents remove the hassle of remembering thumb drives. There is no risk of forgetting or 
losing the document, because everything is stored online. 
 
With access to your files wherever you are, it is easy to find time to create or revise documents 
and share them with others.  
 
The ease of sharing and ability to view comments and feedback on a single version of a 
document makes Google Docs an ideal platform for peer reviews and revision cycles. 
 
An advantage for teachers is to jump in the writing process earlier. When a document is shared, 
teachers can provide feedback whenever it's important in the revision cycle – not just at 
designated due dates. 
 
Comprehensive document revision history – made possible by nearly continuous autosave – is 
helpful for both teachers and students.  
 
When a student shares a document with a teacher, the teacher can look at a document and 
understand how the document has evolved from early drafts or how peer reviews and 
comments were incorporated into the final product. 
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Spreadsheets 
Spreadsheets in Google Docs allows teachers and students to easily aggregate, organize, and 
analyze information in one place. With advanced tools for sorting, formatting, creating charts, 
visualizing information with gadgets, and entering formulas, shared, online spreadsheets can be 
used in a variety of settings. 
 
Some examples of how teachers can use online spreadsheets: 

 Store a database of contact information for students and parents 

 Use a word cloud gadget to visualize written responses 

Some examples of how students can use online spreadsheets: 

 Collect data from across the web for research 

 Create interactive flashcards with a spreadsheet gadget 

 Format a weekly class schedule 

Presentations 

Developing your slide presentations online in Google Docs makes it easy to share and work 
concurrently on slides with others. With the ability to add drawings, images, and video, you can 
use presentations for a variety of projects. 

 
Some examples of how teachers can use online presentations: 

 Showcase student work on a class website with embedded presentations 

 Create templates that outline specific topics for student presentations 

 Publish “how-to” presentations with screenshots and videos 

 Design certificates to print or to send virtually 

Some examples of how students can use online presentations: 

 Create a slideshow with pictures for a class project 

 Collaborate easily for group presentations 

 Storyboard videos, comic strips, written assignments 
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Forms 
With Google Docs, you can quickly create a form or survey, send it to students, parents, 
teachers, or staff, and keep track of the answers in one spreadsheet. 
 
Since forms are filled out online, there’s no need to enter in results manually. Responses are 
collected and displayed immediately in a corresponding Google Docs spreadsheet which allows 
you to sort, analyze, and visualize the information.  
 
You can send forms to anyone - even those outside of your school Apps domain. Respondents 
can access the form via email, a published webpage, or embedded on a site.  
Forms also generates an automatic summary with charts, graphs, and statistics about your form 
responses and can notify you when new responses are submitted. 
 

Create a Form 

Although forms are part of spreadsheets, you can also select the form type when creating a 
new doc. You can create a new form from your Docs list, from a spreadsheet or from a 
template. 
 
Create a form from your Docs list: 

1. Click Create new…Form 
2. In the form template that opens, you can add any questions and options 

you’d like. 
 

Create a form from a new or existing spreadsheet: 
1. Click the Tools drop-down menu and select Form then 

Create a form.  
2. If you already have names entered in the columns of the 

active sheet, the form will populate with those names as 
questions. 

3. In the form template that opens, you can add any questions or options that you want. 
 

Form Question Types 

When you create a form, you are automatically provided 2 questions. You can edit these 
questions however you like and add additional questions. To collect information you need, 
select from 7 different types of questions. 

1. Drop-down lists with options 
2. Single line text box 
3. Multiple choice 
4. Scale, to ask your invitees to grade something in a scale from 1-5, for instance. 
5. Checkboxes 
6. Paragraph text, which allows for long answers 
7. Grid 
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Add and Edit Questions 

To add questions to your forms, follow these steps: 
1. With your form open 
2. Click Add item at the top of the editing page. 
3. Select the type of question you want to add. 

 

 
 

You can make any question a required question by selecting the option labeled ‘Make this a 
required question’ 
 
Use the icons next to each question to edit, delete or duplicate. 

EDIT: To edit an existing question, just click the Edit button to the right of the question 
you want to edit. 
DELETE: To delete a question, click the Delete button to the right of the question you 
want to delete. 
DUPLICATE: To quickly duplicate a question, click the Duplicate button to the right of the 
question you want to duplicate. 

 
When using your school Apps account, you can choose to record the email addresses of people 
who fill out your form. This can help you identify who submitted the response and also filter to 
find those who submitted multiple responses. 
 
To do this select he checkbox next to ‘Automatically collect respondent’s myschool.org 
username’. Recipients of the survey will see a message at the top of the form explaining that 
their username will be collected automatically.  
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NOTE: If you are inviting people outside of your domain to fill out your form, make sure that 
you don’t require them to sign in; otherwise, they’ll get to the domain sign-in page and won’t 
be able to access the form.  
 

Format Form Appearance 

You can modify the layout of your form by rearranging questions, adding section headers, or 
selecting a designed form. 
 
NOTE: Changing the formatting of your form in this way does not change anything in your 
spreadsheet. Question columns will not move to reflect a new arrangement, section headers 
are not included as a column and the form does not appear while editing the spreadsheet. 
Making the following changes only reflect how individuals see the form. 
 

Rearrange Questions 

You can move questions around simply by clicking and dragging. Make sure that you are not 
editing the question – if you are, you must click the Done button before rearranging your 
questions. 

 
 

Section Headers 

To help make your form easier to read or to organize sets of questions, you 
can add section headers. To add, simply select Section header from the Add 
item drop-down menu. Each section header can have a title, which appears 
in a larger font and a section description. 
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Themes 

There are over 70 themes of all different colors and styles you can choose from for displaying 
the form when viewed as a webpage or embedded on a website. Themes will not appear within 
an email client. 

 
To pick a theme for your form, click the Themes button at the top of the form and select an 
appropriate theme. 
 

 
 
Then, click Apply. 
 

 
 

Allow to Skip or Jump to Sections 

Some forms you create for a diverse audience might require different sets of questions based 
on a previous answer.  
Examples of when a form could have different questions for different respondents: 

 Parents filling our information for the school year, with different questions about 7th 
grade students versus 8th grade students. 

 Students completing a writing assessment, with different prompts depending on the 
book or genre selected. 

By adding page breaks in a form, you can separate information and allow respondents to skip 
irrelevant sections and go direct to other parts of the form. 
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To allow people to move to different parts of a form, use the multiple choice question type and 
select the option labeled Go to page based on answer. 

 
 
To add a page, just click the Add item drop-down menu, and select Page break.  
 
Using page navigation, you can redirect form 
respondents previously split apart back to the 
same page. Under the Add item menu, select 
Page break. Then, select what page you would 
like your form repsondents to be directed to  
under the drop down menu in the page break.  

 

Custom Form Submission Message 

If you have more instructions to provide after respondents complete a form, provide any 
additional information detailing what will happen next, or explain how you will be using the 
submitted information, you can edit the form confirmation message. 
 
To customize the confirmation message, follow these steps: 

1. Go to edit your form if you are not already on the editing page (from the 
spreadsheet, click the Form menu and select Edit form). 

2. Click the More actions button at the top right of the form and select Edit 
confirmation from the drop down menu. 

  
3. Enter your message. You can only include text in this message. 
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Collect Form Responses 
You can email the form to anyone in the world, even those outside your school Apps domain. 
This makes forms an ideal way to collect information for those outside the school such as 
contact information for parents. 
 
If the individual has a Gmail account, they can actually respond to the form directly in the 
email. Others can complete the form by clicking the link included in the message.  
 
The email message you send contains the form title, description, and a link to submit the form. 
At this time, you cannot add a separate email message when you send the form to recipients. 
 
You can email your form as often as you like to recipients from two places: 
 

1. Response spreadsheet: Click the Form menu and select Send 
form. Enter the email addresses and click Send. 

 
2. Editing form page: Click the Email this form button and enter 

the email addresses of the recipients. Click Send. 

 
You can also email recipients again for reminders or other notifications by going to the Form 
menu in your spreadsheet and selecting Email X Recipients, where X is the number of email 
addresses you have already sent the form. 
 
Access the Form with a URL 
Whenever you create a form, Google Docs automatically publishes it with a public URL that 
anyone can access. You can then tweet, IM, email or post the link to inform others about your 
form. 
 
To find the URL for your spreadsheet, follow these steps: 

1. White in the spreadsheet of form responses, go to the Form menu and select Go to live 
form. 

 
 If you are editing the form, click the See responses button and select Spreadsheet to 

get to your main spreadsheet. 
2. Copy the URL of the form. 
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Embed the form on a Website 

Another way to collect information from your form is to post it on a website. For example, you 
can have a volunteer form on a class website or a feedback form on a school website. 
 
If you have a common form that is used by students in your class, you can post that form to the 
class website so students do not need to search for an email or the original URL. This can be 
useful for things like daily or weekly journal entries or reading logs. 
 
If you want to embed your form into a website or blog, after you create and save your form, 
follow these steps: 

 While in the spreadsheet of responses, click the Form menu and select Embed form 
in a webpage…Copy the code and paste into your site or blog.  

 While editing the form, click the More actions button at the top right of your form 
and select Embed from the drop-down menu. Copy and paste the code into your site 
or blog. 

 
 
 
 
 

 

 

 

Automatically Collect User Name 

At this time, it is not possible to limit responses to one per individual. However, when you 
create a form with your school Apps account, you can select to record the email addresses of 
people who fill out your form, and then easily identify any duplicate responses.  
 
You can also use the timestamp included with each form entry to identify the earliest (or latest) 
response from a specific individual. 
 
To automatically include a respondent’s username, select the checkbox next to Automatically 
collect respondent’s msd549c.org username while you create or edit the form.  
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Stop Accepting Form Responses  

When you create a form, you begin accepting responses by default. If you have a specific end 
date or time you will need to manually change the setting. 
 
To stop accepting entries to the form, click the Form menu of your spreadsheet and uncheck 
Accepting responses by clicking on it.  

 

Set Notification for New Form Responses 

You can set notifications to receive emails whenever someone submits a form. These are the 
same notifications that alert you to changes in a spreadsheet. 
 
This can be useful if you have embedded a web form that receives only occasional responses. 
The notification will alert you to any new submission. This can also be useful for tracking and 
graphing the rate of response for your forms. 
 
You can set the frequency of notifications for form responses to be sent right away or 
combined in a single daily email. 
 
To set up notifications for your form, follow these steps: 

1. Click Share at the top right of the form response spreadsheet and select Set Notification 
Rules. 

2. Select When a user submits a form. 
3. Choose the frequency by selecting either daily digest or right away. 
4. Click Save.  
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View Form Results 

Responses to your form are automatically entered into a spreadsheet where you can view, 
organize and visualize your data. 
 
Your form response spreadsheet is created with the same name as your form and acts just like 
any other spreadsheet.  
 
To access your form response spreadsheet from the edit form page, click the See responses 
button at the top right of the form and select Spreadsheet from the drop-down menu. 

 
Finding a form in your Docs list is the same as finding any other document: you can search for 
the form name, browse files owned by you, or look just at the spreadsheet file types. 

Make Changes to the Form Response Spreadsheet 

When you create a form, responses are automatically collected into a sheet in a spreadsheet. 
You can insert or move sheets, sort and perform other operations you would in any other 
spreadsheet. The responses will continue to be collected in the same sheet. 
 
With the sheet where form data is collected, you can do the following: 

 Insert columns to add your own content, such as calculations, notes or lookups, next to 
form responses. 

 Add response data directly to the spreadsheet by adding rows above, below, or 
between your existing response rows. You can add data one row at a time, or paste it in 
in bulk. Rows you add will be absorbed into the table that stores your form’s data. 

 
Some changes to your spreadsheet aren’t allowed, once your spreadsheet is storing form 
responses in a table. This is so that you don’t make changes that would stop your spreadsheet 
from being able to read your form responses properly.  

Automatic Summary of Form Responses 

Google automatically generates basic statistics from the 
responses you receive in a form summary.  
 
The summary calculates totals, percentages, add graphs 
and add snippets of free responses. You will also be able 
to see a graph charting the daily response rate. 
 
From the edit form page, you can access the summary 
by clicking the See responses button and selecting 
Summary form the drop-down menu. 
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To access the summary from your form response spreadsheet, go to the Form menu and select 
Show summary. 

 
The response summary page opens in a new window. 
 
If you want to print your form responses summary, open your browser’s Print menu. 
 
Because the summary is automatically generated, there’s no way to select specific entries to be 
included. If you want to have more control, you can generate charts and graphs as you would 
any other spreadsheet data. 

Design and Deliver Quizzes and Tests Using Forms 

You can use forms to create quizzes and tests with various types of questions. You can then 
post the exam on a website or send it directly to students or other recipients. 
 
To set up an online quiz or test, follow these steps: 

1. Create a new form 
2. Add and arrange questions by clicking the Add Item button at the top of the editing 

page. 
3. Add section headers to organize your exam by clicking the Add item button at the top of 

the editing page and selecting Section header. Enter the section header and a 
description. 

4. Make the form available to students or recipients: 

 Email the form to your class list or individuals by selecting the Email this form 
button and entering in email addresses. Or select the Send form option from the 
Form menu in your response spreadsheet. 

 Embed the form in your site or blog by clicking the More actions button and 
selecting Embed. Copy and paste the code into your site. 

 Embed the form in a Google Site by going to your site, click the Insert menu and 
selecting Form. Pick your form from the list. 

  Post the link to the form. Find the URL in your response spreadsheet by clicking the 
Form menu and selecting Go to live form. Copy the URL of the new window. To get 
to your spreadsheet from the edit form page, click the View responses button and 
select Spreadsheet. 

5. When the time for submitting the form is over, stop accepting responses by going to the 
Form menu in your response spreadsheet and click Accepting responses to remove the 
checkmark. 
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Sites 
You can access Google Sites from any of your school Google Apps product pages. 

1. In the top left corner of any product main page, you will see a list of links. 
2. Click Sites. 

 
You can also access Google sites from: 
http://sites.msd549c.org 
 
Browse Google Sites 
When you see the district’s Google Sites page, you will see a list of your sites on our district’s 
domain. These are sites that you own or have been given access to. 

 
You can also browse all the sites created on our school’s domain 
by scrolling to the bottom of the list and click Browse sites within 
msd549c.org. 

 
From here you will see a list of categories. Categories are added 
to sites by site owners. You can click on a category to view sites 
that have been tagged with that category. 
Categories allow you to group related sites and make them 
accessible together within the popular categories list. Categories 
are deemed popular when they contain more than five sites.  
 
You can click on any of the categories on the left side to view 
more lists of sites. 
  

http://sites.msd549c.org/
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Search  

You can use Google search to find content within your sites or within all the sites at in our 
district. 
 
To search for information on your sites: 

1. Go to Google Sites for your district. 
2. Click inside the search box in the top right corner. 
3. Enter the terms of your search. 
4. Choose from the drop-down menu whether you want to search just your sites or all the 

sites available in the district. 

 
5. Click Search my sites or Search all sites. 

The search result will highlight sites, pages, images or files that relate to your search terms.  

Google Sites 

Google Sites is an online application that makes creating a class, school, or project web site as easy as 

editing a document. With Google Sites, people can quickly gather a variety of information in one place -- 
including videos, calendars, presentations, attachments, and text -- and easily share it for viewing or 
editing with a small group, their class, the entire school, or sometimes the world. You always control who 
has access to your site. 
 
You can allow others to contribute to the site, track the changes made to your site, and add rich media – 
no html programming required.  
 
Here's what you can do with Google Sites: 

 Customize your site. 

 Create sub-pages to keep your content organized. 

 Add navigation menus 

 Choose page types: webpage, announcements, file cabinet, lists, dashboards, start pages. 

 Have a central location for your web content and offline files. 

 Keep your site as private or public as you'd like. 

 Search across your Google Sites content with Google search technology. 
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Know your audience 
 
When you start creating your website, you should always keep in mind the intended audience. This can 
change how you should present the information, what navigation is important etc.  
 
Here are a few things to think about: 

 Who are they? Are they students, teachers, parents, or a mix of all?  

 What are they looking for? What information is most important to them - you will want to 
highlight this information in the design of your site. 

 What's their technical ability? Depending on how familiar they are with technology, you may 
need to provide more or less instructions. 

 Advanced or new users? This will help determine the depth of instruction you should include on 
your site. 

 Are they web savvy users or are they new to the Internet?  
 
Example: https://sites.google.com/site/teacher8/Home 
This site caters to both parents and students. The main page has information that both audiences would 
be interested and links in the navigation provide information specific to either parents or teachers. 

Design - choose a design that flatters, not distracts from your content 
 
Google Sites has several layout and design templates to choose from. One of the easiest ways to create 
a site is to use a pre-designed templates that can set you up with site organization and ideas for content. 
 
In addition to these pre-designed templates, there are also some basic site templates available that let 
you choose a color, font, and graphical scheme for your site. 
 
Here are a few things to think about: 

 Choose appropriate colors, fonts and images for your Site's theme. Try to avoid 'clashing' 
colors, or stick to the default theme colors (the colors were made to match the color scheme) 

 Use whitespace to help separate sections of your site. Whitespace works in many ways - it 
gives your user 'space' to process the webpage, can be used as an 'invisible' divider or 
information, and prevents your site from looking cluttered and confusing. 

 Use images that help explain the material, not distract from it. With all the graphic and image 
sources out there, it can be tempting to try and add images all over your site. Be aware that 
images can distract from the page and add them judiciously (do they add value to the content? 
does it help the user find what they are looking for?) 

 
 
Example: https://sites.google.com/site/teacher25/projekte-proyectos/artistas/gabriele-muenter  
This is a site to showcase student artwork, the background image use of colors matches the theme of the 
Site. 

Content - keep it simple 
 
When someone visits your website, they should be able to quickly browse through the pages and find the 
information they are looking for. One way to achieve this is with headings. Come up with descriptive and 
concise headings to categorize your content. 
 
Here are a few things to think about: 

 Expose the most important information "above the fold." The fold is the point when a user 
has to scroll down to see the rest of the webpage. If your best and most relevant content is 
'hidden' down the page and requires scrolling, you run a risk of a user not seeing it. If at all 
possible, try to keep all your information above the fold. 

 Use headings easy to see and make sense. Headings should stand out - you can bold the text, 
make it a size or two larger. These will be used by the user while scanning the page. The 
headings should also be relevant to the associated content. 

https://sites.google.com/site/teacher8/Home
https://sites.google.com/site/teacher25/projekte-proyectos/artistas/gabriele-muenter
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 Short and sweet paragraphs. A webpage is not the place to be reading long blocks of content - 
text on your page should inform quickly and easily. Keep paragraphs descriptive but concise.  

 15 second rule: if someone has only 15 seconds to review a page, can your expected user 
(teacher, student, parent, other) find the information they need quickly? 

 
Example: https://sites.google.com/site/teacher8/Home  
This site is well organized; the content is well structured and makes a good use of headings. 

Example: https://sites.google.com/site/teacher22 
This site is also well organized and structured.  

Navigation - don't make me think! 
 
When someone visits your site for the first time, they should be able to tell what's within your site just by 
looking at the 5-7 navigation links included in your site. 
 
Here are a few things to think about: 

 Try to use no more than 5-7 links in your main navigation. More than that can be 
overwhelming. Instead of having a long laundry list of links, use sub-pages (pages that are linked 
within the main navigation links) to display additional information or links. Google Sites has an 
option to include subpage dropdown in your main navigation. 

 Use 'breadcrumb' links. 'Breadcrumbs' show a list of the link hierarchy or navigation so that a 
user knows where they've been and where they are going. Google Sites automatically includes a 
breadcrumb on your pages. Sites has breadcrumbs at the top. to get out of the subpage, can go 
back to the main, 'top level' page 

 
Example: https://sites.google.com/site/teacher18/emoh 
This site has a good navigational structure. There are only 6 links in the main navigation. Sub-pages are 
used in this section so the user can see these are subpages of the "how to" section. 
https://sites.google.com/site/teacher18/how-to-1 
 
Example: https://sites.google.com/site/teacher34/  
Here is a site that does not have more than seven elements in the navigation but the navigation is broken 
into separate sections that makes the site easier to browse. 

Dancing Bears - animation can be very distracting. 
 
When you start designing a site, there are many options to add rich media. Take care when adding things 
like animated gifs, elaborate colors and fonts to your site. Google Sites does allow creativity to do this, but 
it can be very distracting. 
 
Here are a few things to think about: 

 Avoid animation. If necessary, have only one per page. An animated image can take the 
attention away from your web content. If the animation is necessary to the information in your 
website, then keep it to a minimum - 1 at most. 

 Avoid noises and music. Opening a website and suddenly hearing music or noises can surprise 
users. Use music and noises only if necessary and relevant to your content - and even then, try 
and use a player that can allow the user to control the sound instead of autoplaying. 

 

 

If You Need Additional Help 

 
NTS Department  
541-842-3650 

https://sites.google.com/site/teacher8/Home
https://sites.google.com/site/teacher22
https://sites.google.com/site/teacher18/emoh
https://sites.google.com/site/teacher18/how-to-1
https://sites.google.com/site/teacher34/
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